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Teacher Guide 

 

Lessons for Middle & High School Students: Grades 6 - 9 

 

 

Technology Project using 

Google Slides 

Design an interactive map. 

 

In this project, students create an interactive map that demonstrates how human and physical 

geography intersect. The topic can be global, national, provincial, state, regional, or local. The 

map will have markers that, when clicked, provide facts about a location. This is a great way to 

explore and learn about an area or issue. 

To start, students study sample maps. Next, using an inquiry-based approach, students select a 

research question to investigate. Students are then guided through creating slides and adjusting 

the flow of information to make a clickable map using Google Slides. Upon completion, their 

interactive map is shared with others. 
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TechnoMap Overview 
  

Purpose: Create an interactive map that 

communicates information about a location. 
Preparation: (see Preparing to Teach) 

• Install Google Chrome 

• Sign up for a Google Account 

• Install Adobe Reader or other PDF app 

• Share Map folder with students 

• Prepare TechnoMap folder for Google Drive 

(optional steps for Assignment 1) 

• Download and print Flashcards and Tool 

Summary from TechnHub (optional) 

 

Objectives: (see Appendix A: Skill Summary) 

• identify a topic area for inquiry 

• investigate a research question 

• organize research findings 

• explain the importance of an area 

• create an interactive map 

• select an appropriate slide layout 

• apply a suitable slide background 

• format text to enhance readability 

• insert and format word art and pictures 

• connect information using hyperlinks 

• critically evaluate an interactive map 

• communicate with an audience 

• explore the interaction between human 

and physical geography 

Materials: (see Appendix B: for a complete list) 

• Map Checklist 

• Map Marking Sheet 

• Map Skill Summary 

• Map folder 

o Workbook Assignment Sheets 

o Sample Maps – Industry, Oil Spill Effects, 

Transcontinental Railroad 

o Organizer template (optional) 

• TechnoMap folder (optional) 

• Parent Letter and Certificate (optional) 

• Flashcards and Tool Summary (optional) 
  

 

Summary of Activities: 

• Gain an understanding of the purpose of an interactive map. View samples. 

• Brainstorm a topic for the interactive map. 

• Investigate a research question. Summarize findings in an organizer. 

• Create a map slide with a Word art title and a suitable map of the area. 

• Create information slides that contain facts about a location.  

• Connect markers on the map to information slides. Troubleshoot problems to control slide 

advancement. 

• Complete the interactive map and use a checklist to guide revisions. 

• Share the interactive map with the teacher or friends. 

 

Extension Activities: 

• Research using Google Docs: Using the Explore tool to search for information. Cite the source. 

• Screen Capture a Road Map: Use Google Maps to save a picture of a road map. 

• Image Workshop: Discover multiple methods to insert images onto slides. 

• Organize Facts using a Table: Summarize information or create a pro/con comparison. 

• Add Hotspots: Insert a hyperlink onto a text box that links to a website about the topic. 
 

 

Assessment: 

• Self-Evaluation (Map Checklist – Assignment 7) 

• Teacher Evaluation (Map Marking Sheet, Map Skill Summary) 

 

 

Notes: 

• If you are a classroom teacher, have students create an interactive map about a topic they are 

studying. 

• If you are a computer teacher, have students build an interactive map about a family holiday, 

neighborhood hotspots, or personal exploration of themselves.  
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Technology Integration Ideas 

TechnoMap integrates into curriculum. Students create an interactive map that explores how 

human and physical geography intersect. The map can be of the world, country, province or 

state, region, or a city. Select a topic based on an area of study within geography, history, or 

social studies curriculum. Below are some suggestions: 

 

• People and Places: Explain how the land influences human activity. Map the use of 

natural resources, industry, or recreation in an area. 

• Historical Exploration: Explore a time period or event in history. Map the location and 

detail the importance of historical battles, treaties, and exploration routes. 

• Celebrate Differences: Pinpoint what makes an area unique. Map each region and 

explain what makes it different. 

• Current Events: Report what is happening around the world, across the country, or in your 

own hometown. Map the site of each event and provide the facts. 

• National Pride: Express why you love your country or city. Use cultural symbols to identify 

sites, events, landforms, or other locations that make it a great place to live. 

• Environmental Awareness: Investigate an environmental issue. Map the impact it has had 

on an area. 

• Tourist Attractions: Plan a trip or highlight reasons to visit an area. Map places that tourists 

will want to see. 

• Label It: Label parts of a map. Provide facts and pictures about each location. 

• Personal Map: Take a photograph of yourself. Place a map marker over your head that 

connects to a slide that tells about your beliefs, current mental state, dreams, or what 

you are thinking. Place a map marker over your heart that connects to a slide that 

expresses what you value or love. Place a map marker over your hands or feet that 

connects to a slide that reveals what you like to do, hobbies, interests, or skills. 

 

Understand the Big Picture 

 

Not sure where to integrate TechnoMap?  

 

There are 3 samples provided for this project. The first sample is about Industry in Ontario. It 

examines how a few select industries affect the economy. The second sample is of the Gulf of 

Mexico. It explores the environmental impact of the oil spill in 2010. The third sample is of the first 

Transcontinental Railroad. It looks at how the need for more efficient travel was developed. 

These samples provide ideas on how you can integrate these activities into your curriculum. 
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map slide 

There are "tricks" to 

restricting slide 

advancement that 

you will learn so you 

can control the flow 

of information. 

 

Assignment 1  What is an Interactive Map? 
 

 
 

 

What is an Interactive Map? 

 

An interactive map contains markers that, when clicked, explain facts about the location. This is 

a great way to communicate information. You can make an interactive map that allows people 

to explore and learn. For example, the map can be about an area's: 

 

• transportation system 

• waterways 

• natural resources 

• landmarks 

• distinct regions 

• environment 

• economy 

• industry 

• agriculture 

• manufacturing 

• tourism 

• recreation 

• history 

• indigenous people 

• culture  

• national identity 

• current events 

• heritage  

 

 

You will be making an interactive map using Google Slides. On the first slide you will add a map. 

Markers will be placed onto the map to pinpoint areas of importance. Slides will be created 

providing information about each area. Markers will be added to the first slide and hyperlinks will 

connect markers to information slides. 

 

 

   
 

 

  

In this project, you are going to create an interactive 

map using Google Slides.  

 

To prepare for this activity study sample maps to gain 

ideas about how you can creatively communicate 

information about a location. 

information slides 

map marker 
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Study Sample Interactive Maps 

 Ask your teacher how to view the maps.  

 

1. View the industry sample. Answer the questions.  

a. Click the tractor symbol. What information is displayed? 

 

 Agriculture in Ontario 
  

b. Click anywhere on the information slide.  

What happens? 

 Return to interactive map. 
  

c. The interactive map has been created so that information flow is controlled. 

Click anywhere on the interactive map. Do NOT click a symbol. What happens? 

 Nothing 
  

d. Click on the other two symbols. What information do they communicate about industry? 

 Mining and Forestry in Ontario 

 

 

2. Return to the Map folder. View the Oil Spill Effects sample. Answer the questions. 

a. An interactive map can be used to describe an 

environmental issue. Look at the slide background.  

What does the design tell about the area? 

 

 It shows an actual photo of the oil spill. 
  

b. Click a black marker. What information is on the slide? 

 Facts about: Deep-water Coral, Ridley Sea Turtle, Bluefin Tuna 
  

c. Return to the map. Click Deepwater Horizon Oil Spill Facts.  

What information is included in the table? 

 Facts about oil spill: status, human cost, oil spilled, spill time, boom used, fines, solutions 

 

 

3. Return to the Map folder. View the Transcontinental Railroad sample.  

Answer the questions. 

a. An interactive map can be used to detail the 

importance of a historical event. Click the Pros and Cons 

train symbol. What is on the information slide? 

 

 Table listing pros and cons, link to a website about the railroad 
  

b. Explore the interactive map. What do you like about the 

design? 

 e.g. background, map, word art, transparent text boxes, crop images 

Get ideas for making your 

own interactive map. What 

do you like? 
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Assignment 4  Create the Map Slide 
 

Using your research organizer, start to construct your interactive map. In this 

assignment you will:  
 

✓ create a map title using Word art 

✓ insert a picture of a map 

✓ add a text box that provides instructions 

 

Login to Google Drive and Create a Presentation 

 Sign into Google Drive. 

 Click New. Select Google Slides.  

 

Rename the File 

 In the TOP LEFT CORNER, click Untitled presentation. 

Type a Map Name. Press ENTER. 

 

Change Slide Layout to Blank 

 Close the Themes sidebar if it is open.  

 Click Apply layout  from the Slides toolbar. Choose Blank  

or from the Slide menu, click Apply Layout and choose Blank.  

 
 

Add a Map Title Using Word Art 

 Click the Insert menu and choose Word art.  

 Type the Map Title. Press ENTER. 
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Format the Word Art 

 With the Word art selected, click Font and pick a style for the letters.  

 

 To change the letter size, rest the cursor over a handle. When it turns into a two-way 

arrow, drag IN to make the title smaller or OUT to make it larger.  

 Position the Word art on the slide:  

Rest the mouse over the Word art.  

When the cursor turns into a four-way arrow , drag into position.  

 

 Fill the Word art with a color that suits the topic. Click Fill color.  

Click Solid or Gradient. Pick an option. 

 

 Format the outline around the letters. Click Border color.  

Pick Transparent if you do not want a line OR a color if you do. 

 IF you have an outline: 

o Set the thickness. Click Border weight.  

From the menu select an option. 

 

o Set a line style. Click Border dash.  

From the menu select an option. 

  

Double click or right 

click on the Word art 

and choose Edit Text 

 to make changes. 

Pick a font that 

is easy to read. 
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Insert a Picture of a Map 

 Click Insert Image  

or from the Insert menu, select Image.  

 From the submenu, click Search the web.  

o In the Search in Google Images pane, type location map (e.g. Ontario map, map of 

Ontario, street map of Ontario). Press ENTER. 

o Scroll through the pictures until you find one you like.  

o Select the image.  

o Click Insert if it is suitable or deselect the image and try again. 

 
 

 Use your skills to resize , place , apply a border , and set border color.  

 
 

Add a Text Box with Instructions 

 Click Text box.  

Click and drag to draw a text box on the slide. 

 Type instructions that will tell the viewer to click on map markers. 

 Select the text, click Font and pick a style for the letters.  

 Click Text color and choose a color from the palette.  

 

 Use your skills to format the text box fill , border color , and border weight.  

 

 
  

DESIGN TIPS 

Crop the picture into a shape. Click the Crop Image arrow .Choose a category and then select a 

shape. 

The map covers the word art. Adjust object order. Select the map, choose Order > Send to back from 

the Arrange menu. 

TIP | Use a Shape instead of a Text box 
 

Click Shape . Choose a category and a shape. Click and drag to draw a shape. Type to add text.  

If you cannot find a map 

use Extension Activity 2 or 3 

to save a picture. 
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Add a Slide Background (Optional) 

 

 
 

 Right click on the slide background. Choose Change background.  

 

Option 1: Choose a Color 

 Click the arrow beside Color and pick a color.  

 

 Click Done. 

 

Option 2: Choose a Picture using Search 

 Beside Image, pick Choose image.  

 
 

 

 Click Google Images.  

o In the search box, type a search word. Press ENTER. 

o Scroll through the pictures until you find one you like.  

o Click on it and then click Insert. 

 Click Done. 

 

Log Out from Google Drive 

You may like the white slide background. However, 

you may want to add a splash of color or use a picture 

as a background. If you do, follow these instructions. 

Pick a picture that is wide. 

This will look the best. 

Pick a solid color or 

click Gradient to see 

more choices. 
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Assignment 6  Connect Slides in Interactive Map 
 

In this assignment you use hyperlinks to control the flow of information on the interactive map. 

You will:  
 

✓ add a map marker and insert a hyperlink to an information 

slide 

✓ resolve slide advancement problems to control flow of 

information on the map slide 

✓ use skills to add remaining map markers 

✓ connect each information slide to the map slide 

 

Log into Google Drive and Open the Interactive Map 

 Display the title slide. 

 

Add a Map Marker 

 

You need to place markers onto your map. A marker can be a symbol of an object to represent 

the information it will lead to, or it can be a simple push pin.  

 

 
 

 Click Insert Image  

or from the Insert menu, select Image.  

 From the menu, click Search the web.  

o In the search pane, type map marker or other symbol. Press ENTER. 

o Scroll through the pictures until you find one you like.  

o Click on it and then click Insert. 

 

 Use your skills to resize  and place  the marker on the map. 

Map Marker Search Words 
Add clip art or clipart to your search word. 

 

• map marker • map pointer • map markers 

• push pin • object name 
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Insert a Hyperlink onto the Map Marker 

 Select a map marker on the slide.  

 Click Insert link.  

 Select Slides in this presentation 

Pick the appropriate slide from the list. 

 

 To edit the link, click on the marker.  

Click  to edit or  to remove the link. 

 
 

View Interactive Map to Discover a Problem with Slide Advancement 

 Click Slideshow.  

 Click the map marker.  

 
 

 Click Previous until you return to the map slide.  

 

 Click ANYWHERE on the map.  

 

 Press ESC to exit presentation mode. 

  

What happens?  

You go to the information slide. 

What happens? You go to an information slide! 

 

You need to fix this problem! Only the map 

markers should advance slides. 

If you can't see the 

entire list of slides, use 

the down arrow key 

on the keyboard to 

scroll down the list. 
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Add a Shape with a Hyperlink to Control Slide Advancement 

 

ONLY a map marker should advance slides. You are going to add a shape with a hyperlink that 

will be used to control the flow of information. 

 

Draw a Rectangle over the Map Slide 

 Display the title slide. 

 Click Shape.  

Click the Shapes category, then select the rectangle. 

 

 Draw a box on a portion of the map slide. 

 

 Change the Fill color to Transparent.  

 
 

Insert a Hyperlink that Connects to the Map Slide 

 With the rectangle selected, click Insert link.  

 Select Slides in this presentation 

Pick Slide 1 from list. (It is the map slide.) 

 
 

  

When a person clicks on 

the map slide; they will 

now be clicking the shape. 

The shape is now linked to 

the title slide, so they will 

not move. 
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 Resize the rectangle to cover the ENTIRE map slide. 

 
 

View Interactive Map to Discover a Problem with the Map Marker 

 Click Slideshow.  

 Click ANYWHERE on the map.  

 
 

 Click the map marker. 

 

 

 Press ESC to exit presentation mode. 

 

Change the Object Order of the Map Marker to Fix the Problem 

 Select the rectangle. Resize it so that you have access to the map marker. 

 Right click the map marker. 

From the menu select Order.  Select Bring to front. 

 
  

What happens?  

You stay on the map slide. 

What happens? You can’t click the marker. 
 

You need to fix this problem! The map marker 

must be on top of the shape. 

Be sure the rectangle 

covers the entire slide. 
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 Resize the rectangle to fill the slide. 

 Align the rectangle on the slide: 

o Right click the rectangle. 

From the menu select Center on page. Select Horizontally. 

o Right click the rectangle AGAIN. 

From the menu select Center on page. Select Vertically.  

 

 Test the Presentation  

o Click Slideshow.  

o Click ANYWHERE on the map. It should NOT advance. 

o Click on the MAP MARKER. It should advance to the information slide. 

 Press ESC to exit presentation mode. 

 

Add Remaining Map Markers to Connect to Information Slides 

 Use your skills to add more map markers.  

Connect each one to the correct information side.  

 
 

 
 

View Interactive Map to Discover another Problem with Slide Advancement 

 Click Slideshow.  

 Click a map marker.  

 Click ANYWHERE on the information slide.  

 

 Press ESC to exit presentation mode. 

 

  

TIP  

The new map markers are added ON TOP of the rectangle so there is no need to adjust object order. 

What happens? You go to the next slide! 
 

You need to fix this problem! When an information 

slide is clicked it should display the map slide.  
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Add a Shape with a Hyperlink to Information Slides to Fix Problem 

 View the first information slide (slide 2). 

 Draw a rectangle.  

 Change the fill color to Transparent.  

 Add a hyperlink to go to the map slide: 

o With the rectangle selected, click Insert link.  

o Select Slides in this presentation 

Pick Slide 1 from list. (It is the map slide.) 

 Resize the rectangle to cover the entire slide. 

 

 Repeat on the other information slides. 

 
 

Check the Links 

 Display the map slide and click Slideshow.  

o Click a map marker. 

o Click the information slide. It should take you back to the map slide. 

o Check the remaining markers and information slides. 

 Make any adjustments. 

 

Log Out from Google Drive

Each information slide 

should have a rectangle 

with a hyperlink that 

connects to the map slide. 
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Extension Activity 4: Organize Facts using a Table 

What type of facts or figures do people want to know about your topic? Using a table is a great 

way to communicate information clearly. A table is a grid made up of rows and columns. Row 

headings can be added to the first column. Information is then placed in each table row. 

 

 
 

Follow the instructions to create a table.  

 

1. Open the Interactive map in Google Slides. 

2. Select the last slide thumbnail. 

3. Click the New slide arrow.   

4. Select the Title Only layout. 

  
  

5. Click in the title placeholder and type a Title. 

6. Create a table. 

 

 a. Click the Insert menu and select Table.   

 b. Drag the cursor over the grid until the table is 2 x 2, then click to apply. 

 c. Hold the cursor over the table border until it turns into a four-way arrow. 

  d. Drag the table to position it below the title. 

  

7. Add the row headings into column 1. 

 

 

 
  

TIP | Change the Number of Rows or Columns 
 

Add a row quickly: Position the cursor in the rightmost cell of the bottom row. Press TAB. 

Add a row/column: Click and drag to select a row/column. Right click on the selection and 

choose an option to insert a row or column. 

Remove a row/column: Click and drag to select a row/column. Right click on the selection 

and choose Delete row or Delete column. 
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8. Adjust column width to make more room for the facts.

a. Hold the cursor over the vertical border in the middle of the table.

b. When the cursor turns into a two-way arrow, drag the border line to the LEFT.

9. Add the facts into the table.

10. Use your skills to format the text:

11. Fill the row headings with color:

a. Select column 1.

b. Click the Fill color tool. Select an option from the palette.

12. Apply a border line:

a. Click and drag to select ALL the CELLS.

b. Pick a border color  and border weight. 

13. Add a link from the table slide to the map slide:

a. Add a rectangle to cover the slide.

b. Set the fill color to transparent.

c. Insert a link to connect to the map slide.

14. Move to the map slide.

a. Add a map marker or shape and text to describe the content such as Pros & Cons

or Interesting Facts.

b. Insert a link to connect to the table slide.

15. Click Slideshow  and test the links. 



Copyright © TechnoKids Inc. 28 TechnoMap | Google Workspace 

Appendix A: Assessment Tools 

Interactive Map Marking Sheet 

Navigation 

• On the map slide, ONLY the map markers advance slides.

• Map markers connect to correct information slides.

• All information slides connect to the map slide when clicked.
/3 

Content 

• Each map maker is placed in the correct location.

• The information on each slide is interesting and tells about the location or topic.

• Spelling on all slides is correct.
/16 

Design 

• The map is suitable to the topic.

• Slide backgrounds are attractive and enhance the message.

• The information on each slide is formatted so that it is easy to read.
/6 

Comments: 

/25 

Click on the map below to see a sample project in your web browser.
View it as a slideshow. Explore the links to see additional pages.



In 2010, the Deepwater 
Horizon oil rig exploded 
and caused about 5 million 
barrels of oil to spill into 
the Gulf of Mexico. Click 
the map marker symbols 
to learn about the 
environmental damage.Deepwater 

Horizon Oil 
Spill Facts

Deep-water 
Coral

Bluefin Tuna

Ridley Turtle

Click on the map to see a smaple project in




